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SOLIDWORKS® 2020 Quick Start Overview of SOLIDWORKS® and the User Interface

Chapter 1
Overview of SOLIDWORKS® 2020 and the User Interface
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Below are the desired outcomes and usage competencies based on the completion of
Chapter 1.

Desired Outcomes: Usage Competencies:

e A comprehensive e Ability to establish a SOLIDWORKS session.
understanding of the
SOLIDWORKS® 2020 User | ® Aptitude to utilize the following items: Menu
Interface (UI) and bar toolbar, Menu bar menu, Drop-down
CommandManager. menus, Context toolbars, Consolidated drop-

down toolbars, System feedback icons,

Confirmation Corner, Heads-up View toolbar,

Document Properties, and more.

e Open a new and existing SOLIDWORKS part.

e Knowledge to zoom, rotate and maneuver a
three-button mouse in the SOLIDWORKS
Graphics window.

PAGE 1-1



Overview of SOLIDWORKS® and the User Interface SOLIDWORKS® 2020 Quick Start

Notes:
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Chapter 1 - Overview of SOLIDWORKS® 2020 and the User Interface

Chapter Objective

Provide a comprehensive understanding of the SOLIDWORKS® default User Interface
and CommandManager: Menu bar toolbar, Menu bar menu, Drop-down menu, Right-
click Pop-up menus, Context toolbars/menus, Fly-out tool button, System feedback icons,
Confirmation Corner, Heads-up View toolbar, and more.

On the completion of this chapter, you will be able to:

e Utilize the SOLIDWORKS 2020 Welcome dialog box.

e Establish a SOLIDWORKS 2020 session.

e Comprehend the SOLIDWORKS 2020 User Interface.

e Recognize the default Reference Planes in the FeatureManager.
e Open a new and existing SOLIDWORKS part.

e Utilize SOLIDWORKS Help and SOLIDWORKS Tutorials.

e Zoom, rotate and maneuver a three-button mouse in the SOLIDWORKS Graphics
window.

What is SOLIDWORKS®?

e SOLIDWORKS® is a mechanical design automation software package used to build
parts, assemblies and drawings that takes advantage of the familiar Microsoft®™
Windows graphical user interface.

e SOLIDWORKS is an easy to learn design and analysis tool (SOLIDWORKS
Simulation, SOLIDWORKS Motion, SOLIDWORKS Flow Simulation,
Sustainability, etc.), which makes it possible for designers to quickly sketch 2D and
3D concepts, create 3D parts and assemblies and detail 2D drawings.

e Model dimensions in SOLIDWORKS are associative between parts, assemblies and
drawings. Reference dimensions are one-way associative from the part to the drawing
or from the part to the assembly.
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Start a SOLIDWORKS 2020 Session

Start a SOLIDWORKS 2020 session and familiarize yourself with the SOLIDWORKS User
Interface. As you read and perform the tasks in this chapter, you will obtain a sense of how to
use the book and the structure. Actual input commands or required actions in the chapter are
displayed in bold.

The book does not cover starting a SOLIDWORKS session in detail for the first time. A
default SOLIDWORKS installation presents you with several options. For additional
information, visit http:/ www.SOLIDWORKS.com.

Activity: Start a SOLIDWORKS 2020 Session.

Start a SOLIDWORKS 2020 session.
1) Type SOLIDWORKS 2020 in the Search window.

2) Click the SOLIDWORKS 2020 application (or if available, double- £ SOLIDWORKS 2020|
click the SOLIDWORKS icon on the desktop). The

All Apps Documents Email Web
SOLIDWORKS Welcome dialog box is displayed ” '
by default. Best match
The Welcome dialog box provides a wv 1@ souowgzxs 2020 5
convenient way to open recent documents - P

(Parts, Assemblies and Drawings), view

recent folders, access SOLIDWORKS
Home Recent Learn Alerts
resources, and stay updated on
SOLIDWORKS news. et
) . @ part @ Assembly Drawing Advanced... R open

3) View your options. Do not open a

document at this time. Recent Documents View all

Bushing.SLDDRW Fly Wheel. SLDDRW FLY WHEELSLDDRW Fly Wheel SLDASM Bracket SLDPRT
4) If the Welcome dialog box is not Y E ‘ "
. . 5 ~@. N4
displayed, click the Welcome to A i L 1
N ¥ - @ @

SOLIDWORKS icon from the

Standard toolbar or click Help > < >

Welcome to SOLIDWORKS from the | et foltes VISRl o NS

Main menu s T —— @ What's New B Beta Home

' B e MySolidWorks Beta Hot Issues
D g\zgvzo SOLIDWORKS Quick Start\SOLIDWORKS 2020 Instr., bt = petzForum ﬁ] Repon @ Beta ssue
@ Arrow keys rotate the model. Ctrl + Arrow Keys pan the model. Alt + Arrow Keys rotate the model clockwise and counterclockwise. <
[ o not show on startup
v + OYDR -2 1 -
véome to SOLIDWORKS Ctrl+F2

d

SOLIDWORKS CAM
(@ Help

Tutorials
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SOLIDWORKS® 2020 Quick Start

Home Tab

The Home tab lets you open new and existing
documents, view recent documents and
folders, and access SOLIDWORKS
resources (Part, Assembly, Drawing,
Advanced mode, Open).

Recent Tab

The Recent tab lets you view a longer list of
recent documents and folders. Sections in the
Recent tab include Documents and Folders.

The Documents section includes thumbnails
of documents that you have opened recently.

Click a thumbnail to open the document, or
hover over a thumbnail to see the document
location and access additional information
about the document. When you hover over a
thumbnail, the full path and last saved date
of the document appears.

Learn Tab

The Learn tab lets you access instructional
resources to help you learn more about the
SOLIDWORKS software.

Sections in the Learn tab include:

e Introducing SOLIDWORKS. Open
the Introducing SOLIDWORKS book.

e Tutorials. Open the step-by-step
tutorials in the SOLIDWORKS
software.

e  MySolidWorks Training. Open the
Training section at MySolidWorks.com.

¢ Introducing SOLIDWORKS
(Samples). Open local folders
containing sample models.

e Tutorials (Samples). Open the
SOLIDWORKS Tutorials (videos)
section at solidworks.com.

[ ]

Overview of SOLIDWORKS® and the User Interface

Home Recent Learn Alerts
RS
New

@ Assembly

FRONT-SUPPORTSL.

Recent Folders

i) Chopter4 - Homework
DA2020 SOLIDWORKS ENGINEERING DESIGNY

i Chopter2- Homework

3 02020 souomors excinesan ossion

AirCylinder SLDASM

Drawing Advanced...

Hole Wizard 220SL.

n, W, @

View all Resources

NENGDESIGN. @ What's

MySoli

D\2020 SOLIDWORKS ENGINEERING DESIGN\ENGDESIGN.
¥ Beta Forum

NENGDESIGN.

|

[ open

View all

Fill Pattern 222 SLDP. Fill Pattern 221.5LDP.

NS
A
&

i |
QL a
Lg

New B Beta Home

idWorks Beta Hot Issues

(@ Report a Beta Issue

[Bushing SLDDRW

= @
©

&2 =
==

Fly Wheel SLDDRW.

63

Bushing SLOPRT AxleSLDPRT

Draw1.SLDDRW

Fly Wheel SLDDRW.

@ Arrow keys Ctrl + Arrow Keys Alt + Arrow Keys rotate the model clocky < )
0] Do not show on startup

3
Documents  Folders Browse...
Quickfiter: | @ |B| T | Filter by name Remove v

FLY WHEEL.SLDDRW
e
e

=T

=
{34

Wheel SLDPRT

&

AutoBalloon 13-1SL.

Fly Wheel SLDASM BracketSLDPRT

g@

2MM Set ScrewSLDP.

o
®
Collar.SLDPRT

® o

Projected View 13-1... tiring Engine Modif.

d @

Home ~Recent Liam  Alerts
<

Introducing SOLIDWORKS
+ SOLIDWORKS Fundamentals.

« Parts, Assemblies and Drawings

« Engineering Tasks

..and more

Samples
Introducing SOLI... Tutorials What's New
Samples Samples Samples MySolidWorks
& ‘ & a; A Q CAD Models
@ Online Tutorials & My Training R Certfication # Curriculum

[ 0o not show on startup.

Tutorials

MySolidWorks Training

+ Unlimited 24
 Follow along using example files

- Test your knowledge

What’s New (Samples). List of new changes.
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e MySOLIDWORKS - CAD Models. Open models in 3D ContentCentral and the

Community Library.

e My Training. Open the My Training section at MySolidWorks.com.

e Certification. Open the SOLIDWORKS Certification Program section at

solidworks.com.

e Curriculum. Open the Curriculum section at solidworks.com.

R

AR When you install the software, if you do not install the Help Files or Example Files, the
Tutorials and Samples links are unavailable.

Alerts Tab

The Alerts tab keeps you updated
with SOLIDWORKS news.

Sections in the Alerts tab include
Critical, Troubleshooting, and
Technical.

R

“¥" The Critical section does not
appear if there are no critical alerts
to display.

e Troubleshooting. Includes
troubleshooting messages and
recovered documents that used
to be on the SOLIDWORKS
Recovery tab in the Task Pane.

-: /: . El simulation
If the software has a technical C\Users\Public\Documents\SOLID]
problem and an associated troubleshooting message exists, the [ Manuals
. . . C\Program Files\SOLIDWORKS Co
Welcome dialog box opens to the Troubleshooting section

automatically on startup, even if you selected Do not show at it -

startup in the dialog box.

e Technical Alerts. Open the contents of the SOLIDWORKS I__ng not show on startup
Support Bulletins RSS feed at solidworks.com.

Close the Welcome dialog box.

5) Click Close * from the Welcome dialog box. The SOLIDWORKS
Graphics window is displayed. Note: You can also click outside the
Welcome dialog box, in the Graphics window.

Home Recent Learn AIFrts
5

Troubleshooting Technical Alerts

SOLIDWORKS 2020 B2.1 online is now available for testing!
Mon, 29 Jul 2019 00:00:00 EST

WANTED: Splash Screen Contest Entries!
Sun, 21 Jul 2019 13:20:44 EST

Your Free Licenses in Beta2 are...
Mon, 15 Jul 2019 00:00:00 EST

SOLIDWORKS 2020 Beta online is here!
Mon, 01 Jul 2019 00:00:00 EST

Free product licenses, contest information, known issues and more on the Beta Forum...
Mon, 24 Jun 2019 00:00:00 EST

SOLIDWORKS 2020 Beta is Live!
Mon, 17 Jun 2019 00:00:00 EST

Your Free Licenses in Beta1 are...
Mon, 17 Jun 2019 00:00:00 EST v

[ Do not show on startup

Recent Folders

Final models

@ Arrow keys rotate the model. Ctrl + Arr
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View the SOLIDWORKS Graphics window.

Zs souwors| File View Tools Help # [ 42} [ -[R%+-| - -0+ s - -
|

# Welcome to SOLIDWORKS

@ 'SOLIDWORKS Tools
@ @Property Tab Builder

® SOLIDWORKS Rx
@ Performance Benchmark Test

@Compare My Score

i Copy Settings Wizard

€ v

Online Resources
& @ 3DEXPERIENCE Marketplace

7 o
S SOLIDWORKS

@ Subscription Services

If you do not see this screen, click the SOLIDWORKS |« SOLIDWORKS Resources 7 # |

Resources & icon on the right side of the Graphics window  Welcome to SOLIDWORKS
located in the Task Pane.

6) Hover the mouse pointer over the SOLIDWORKS icon.

SOLIDWORKS Tools &
@ Property Tab Builder

@ SOLIDWORKS Rx

@ Performance Benchmark Test

7) Pin * the Menu Bar toolbar.

@ Compare My Score

8) View your options from the Menu bar menu: File, View,
Tools and Help.

4 Copy Settings Wizard

% My Products

Online Resources o
@ 3DEXPERIENCE Marketplace

3 M H@@E{

swPartner Solution:

p??sotjawows ¢ File View Tools Help =
D
D7SSOLIDWORKS File View Tools Help T}L@ - /"7v - - - - u{(i)}v
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Menu Bar toolbar

»

AD-FE-8-9N0ES

2
DS SOLIDWORKS

The SOLIDWORKS (UI) is designed
to make maximum use of the Graphics window. The

Menu Bar toolbar contains a set of the most frequently | ® search knowledge ase = Q- 2 ~ _ ] X

used tool buttons from the Standard toolbar.

The following default tools are available:

e  Welcome to SOLIDWORKS O Open the Welcome dialog box, New 1) - Create a
new document; Open arg8 Open an existing document; Save & - Save an active
document; Print = Print an active document; Undo = Reverse the last action;

Select o Select Sketch entities, components and more; Rebuild @ - Rebuild the active
part, assembly or drawing; File Properties = - Show the summary information on the

active document; and Options B . Change system options and Add-Ins for
SOLIDWORKS.

Menu Bar menu

Click SOLIDWORKS in the Menu Bar toolbar to ;;.?S SOLIDWORKS | Fle View Tools Help 4

display the Menu Bar menu. SOLIDWORKS

provides a context-sensitive menu

Structure The menu tltleS remaln the p;'SSOL'DWORKS 4 Fle Edit View Insert Tools Window Help 44

same for all three types of
documents, but the menu items change depending on which type of document is active.

Example: The Insert menu includes features in part documents, mates in assembly
documents, and drawing views in drawing documents. The display of the menu is also
dependent on the workflow customization that you have selected. The default menu items for
an active document are File, Edit, View, Insert, Tools, Window, Help and Pin.

The Pin * option displays the Menu bar toolbar and the Menu bar menu as illustrated.
Throughout the book, the Menu bar menu and the Menu bar toolbar are referred to as the
Menu bar.

%SOLIDWORKS & File View Tools Help 44

%SOLIDWORKS[E‘ File Edit View Insert Tools Window Help 43

JDZSSOLIDWOR‘KS File Edit View Insert Tools Window Help ﬂ @ '@vv gv v @v
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SOLIDWORKS® 2020 Quick Start

Drop-down menu

SOLIDWORKS takes advantage of the familiar Microsoft® Windows

user interface. Communicate with SOLIDWORKS through drop-

down menus, Context sensitive toolbars, Consolidated toolbars or the

CommandManager tabs.

w1
A

perform a task.

To close a SOLIDWORKS drop-down menu, press the Esc key. You
can also click any other part of the SOLIDWORKS Graphics window

or click another drop-down menu.

Create a New Part Document

In the next section create a new part document.

A command is an instruction that informs SOLIDWORKS to

Overview of SOLIDWORKS® and the User Interface

File Edit View Insert Tools Window Help

Ctrl+N
Ctrl+O

New...
¥ Open...

Open Recent
Open Drawing

% Close Ctrl+W

58 Make Drawing from Part
@ Make Assembly from Part

& save

3]

Ctrl+S
Save As...

@ saveal

Page Setup...
@ Print Preview...
& Print..
[ Print3D...

Ctrl+P

4& Publish to eDrawings

™ Pack and Go.
Send To...

Find References...
[ Properties...

Exit

Customize Menu

Activity: Create a new Part Document.

A part is a 3D model, which consists of features. What are
features?

Features are geometry building blocks.
Most features either add or remove material.
Some features do not affect material (Cosmetic Thread).

Features are created either from 2D or 3D sketched profiles
or from edges and faces of existing geometry.

Features are individual shapes that combined with other
features make up a part or assembly. Some features, such as
bosses and cuts, originate as sketches. Other features, such as
shells and fillets, modify a feature's geometry.

Features are displayed in the FeatureManager as illustrated
(Boss-Extrudel, Cut-Extrudel, Cut-Extrude2, Mirrorl,
Cut-Extrude3 and CirPatternl).

“¥" The first sketch of a part is called the Base Sketch. The
Base sketch is the foundation for the 3D model. The book
focuses on 2D sketches and 3D features.

w1
-~ Y

FeatureManager tabs and tree folders will vary
depending on system setup and Add-ins.

PAGE 1-9
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‘% TRIANGLE (Default<<Defaults|

N
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History
Sensors

4 Design Binder

4 Annotations

» [®@)]Solid Bodies(1)
Equations
55 Material <not specified>
m Front Plane

ﬂj Top Plane
m Right Plane

I__ Origin

@ Boss-Extrude
C Sketch1

Cut-Extrude
C Sketch2

Cut-Extrude2
C Sketch3

[hllﬂ Mirror1
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There are two modes in the New

New SOLIDWORKS Document X

SOLIDWORKS Document dialog
box: Novice and Advanced. The

Novice option is the default option
with three templates. The i
Advanced mode contains access to £h

additional templates and tabs that
you create in system options. Use
the Advanced mode in this book.

Part Assembly Drawing

a 3D representation of a single design a 3D arrangement of parts and/or other  a 2D engineering drawing, typically of a
component  assem blies part or assembly

Create a new part. Novice mode

9) Click New [ from the Menu oK Cance Help
bar. The New SOLIDWORKS

Document dialog box is
displayed.

New SOLIDWORKS Document X

~
Select the Advanced mode. Templates MBD  Tutorial
10) Click the Advanced button as mEm = 3=

. Assembly -
illustrated. The Advanced Drawing Preview

mode is set.

11) Click the Templates tab.

12) Click Part. Part is the default
template from the New
SOLIDWORKS Document
dialog box.

13) Click OK from the New
SOLIDWORKS Document T = — s
dialog box.

Advanced mode

w1

A [Mlustrations may vary depending on your SOLIDWORKS version and operating system.

The Advanced mode remains selected for all new documents in the current SOLIDWORKS
session. When you exit SOLIDWORKS, the Advanced mode setting is saved.

The default SOLIDWORKS installation contains three tabs in the New SOLIDWORKS
Document dialog box: Templates, MBD, and Tutorial. The Templates tab corresponds to the
default SOLIDWORKS templates. The MBD tab corresponds to the templates utilized in the
SOLIDWORKS (Model Based Definition). The Tutorial tab corresponds to the templates
utilized in the SOLIDWORKS Tutorials.
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Part1 is displayed in the FeatureManager and is the name of the document. Part1 is the default
part window name.

The Part Origin J“ is displayed in blue in the center of the Graphics window. The Origin
represents the intersection of the three default reference planes: Front Plane, Top Plane and
Right Plane. The positive X-axis is horizontal and points to the right of the Origin in the Front
view. The positive Y-axis is vertical and points upward in the Front view. The
FeatureManager contains a list of features, reference geometry, and settings utilized in the
part.

w1 MEKS (meter, kilogram, second)
“¥" Edit the document units directly from the Graphics window as o
illustrated. 1PS {inch, pound, second)
I Edit Document Units.. -
sl Editing Part VT ;
e e

CommandManager and FeatureManager tabs will vary
depending on system setup and Add-ins.

Main Menu Toolbar

-~
55 soupworks  File Edit View Insert Tools Windom * @ D ~B}~- E - !)- ~

C ¢ /0NV#3H DL @
Sketch ~ Smart - (\@ jah Convert Offset

Dimension Entities On

O @ - | . . Surface

Fe;tures S;(e(ch Markup | Evaluate | MED Dimensions | SOLIDWORKS Add-Ins | SOLIDWORKS CAM | S'OLIDWORKSCM'A 8M S
PLENAES » SR 2
o DR o \ ~

(?

. CommandManager Tabs Heads-up View Toolbar
@ Part1 (Default< <Default>_Display

History

[Zsensors Part FeatureManager Task Pane
» [&l Annotations

EMateriaI <not specified>

[ Front Plane

[ Top Plane

[1) Right Plane
I-.Origin \ g\o
Hide/Show rigin

FeatureManager tab

Ll 2 INIEIES

Triad
g

& > *Trimetric
I Model 3D Views | Motion Study 1
oLIDWORKgbremium 20 4 Ty

/

Model Mode 3D Views Motion Mode Units Tags
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View the Default Sketch Planes.

14)
15)
16)
17)

Click the Front Plane from the FeatureManager.
Click the Top Plane from the FeatureManager.

Click the Right Plane from the FeatureManager.

SOLIDWORKS® 2020 Quick Start

Click the Origin from the FeatureManager. The Origin is the intersection of the Front, Top, and

Right Planes.

C ¢ /ONEHDL e
e =R OD Nl o
@-& - = Surface

5 sovoworks File Edit View Insert Tools Window Help i‘ @ D [27 Bf)IE ' {ﬁ}- @ searchknowledgeBaseQ~ & 2 - — 0O X

Features | Sketch | Markup | Evaluate | MBD Dimensions | SOLIDWORKS Add-Ins | SOLIDWORKS CAM | SOLIDWORKS CAM TBM a o

SER N
T

€ Part1 (Default<<Default>_Display E
ron
@) History L o
[ sensors 1)
» [AlAnnotations
B Mater I ® 2-didd>

[ Front[*lane|

J Right Plane
L., origin

b
> *Trimetric
ESEE Model | 3D Views | Motion Study 1 |
art]

<

PLAPRE © oSBT

gle»

K

®

—
i

3

EditingPart  MMGS - @

Download all needed model files (SOLIDWORKS 2020 folder) from the SDC Publication
website (www.SDCpublications.com/downloads/978-1-63057-323-2). Open the Bracket part.

Review the features and sketches in the Bracket FeatureManager. Work directly from a local
hard drive.

Activity: Download the SOLIDWORKS folder. Open the Bracket Part.

Download the SOLIDWORKS folder. Open an existing SOLIDWORKS part.

18)

19)
20)
21)

Download the SOLIDWORKS 2020 folder.

Click Open v/ from the Menu bar menu.
Browse to the SOLIDWORKS 2020\Bracket folder.

Double-click the Bracket part. The Bracket part is
displayed in the Graphics window.

PAGE 1-12
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File Edit View Insert Tools Window Help # ﬁ D .[21/.. Ev‘)vm ' {@}v T searchknowledgeBaseQ~ & 2 - — O X
@ 3 fSwept Boss/Base @ @ ﬁ Swept Cut @ EE @ Rib Wrap .ﬂ U %

Brtruded Revolved  fil | ofted Boss/Base  Brtruded Hole Revolved (T Lofted cut  F1"e* Lo BN prag (N intersect Reference Curves linstai
Boss/Base Boss/Base cut  Wizard  cyt Pattern Geometry

Boundary Boss/Base . @ Boundary Cut . @ Shell '|'{| Mirror

Features ‘ Sketch ‘ Markup ‘ Evaluate ‘ MBD Dimensions =~ SOLIDWORKS Add-Ins ‘ SOLIDWORKS CAM ‘ SOLIDWORKS CAM TBM ‘ g _ 5 X

Jye KE P @ -
&R I6 @R PPLPEPEE 0 o SR
7

2
DS SOLIDWORKS

N]

> [@Solid Bodies(1)
gi Material <not specified>
[ Front Plane

& Bracket (Default< <Defau|t>,Dis\ @
> [@History

[ sensors Part FeatureManager tree E
> [l Annotations
> [ Markups

[ Top Plane
[J Right Plane
L Origin
4 @Extrude—Thim
B Fillett
» [B25.0 (5) Diameter Hole1
EE LPattern1
» [@210.0 (10) Diameter Hole1
EE LPattern2
Cut-Extrude1
EE LPattern3 Y

A

< 2 | *Isometric
- Model \ 3D Views \ Motion Study 1 \

=)

The FeatureManager design tree is located on the left side of the SOLIDWORKS Graphics
window. The FeatureManager provides a summarized view of the active part, assembly, or
drawing document. The tree displays the details on how the part, assembly or drawing
document was created.

Use the FeatureManager rollback bar to temporarily roll back to an earlier state, to absorbed
features, roll forward, roll to previous, or roll to the end of the FeatureManager design tree.
You can add new features or edit existing features while the model is in the rolled-back state.
You can save models with the rollback bar placed anywhere.

In the next section, review the features in the Bracket FeatureManager using the Rollback bar.

Activity: Use the FeatureManager Rollback Bar option.

Apply the FeatureManager Rollback Bar. Revert to an earlier state in the model.

22) Place the mouse pointer over the rollback bar in the FeatureManager design tree as illustrated.

The pointer changes to a hand @l-. Note the provided information on the feature. This is called
Dynamic Reference Visualization.

» @ Extrude-Thin1

B Fillet1

» &) Extrude-Thin1

23) Drag the rollback bar up the FeatureManager B Fillet A
design tree until it is above the features you » [B250 (5) Diameter Hole
want rolled back, in this case 10.0 (10) L LPatternt

H || 1 @Q 0.0 (10) Diameter Hole
Dla “etel olel. 4 Lv}@ 0.0 (10) DiametePdole

» & @50 (5) Diameter Hole1

EE LPattern2

B>
LPattern2 =
ME » Cut-Extrude1
» & Cut-Extrudet B
e LPattern3

EE LPattern3 GF

24) Release the mouse button.
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View the first feature in the Bracket Part.

25)

Drag the rollback bar up the FeatureManager above Fillet1. View the results in the Graphics
window.

s soipworks | File Edit View Insert Tools Window Help x‘ ﬁ .B‘y.ﬁ. gv‘)uz ' {@}v @ searchknowledgeBase Q- & 2?2 - — 0O X
@ 3 fSwepl Boss/Base @ ﬁ Swept Cut @ EE @ Rib Wrap .ﬂ U <%
W

Brtruded Revolved B | ofted Boss/Base Extmded e Re"""'ed QO tofted cur Pt Lineer BN b (DN ngersect Reference Curves
Boss/Base Boss/Base Cut  Wizard  cyt Pattern Geometry

Boundary Boss/Base Boundary Cut . @ Shell '|‘{| Mirror

i

Features ' Sketch ‘ Markup ‘ Evaluate ‘ MBD Dimensions ‘ SOLIDWORKS Add-Ins ‘ SOLIDWORKS CAM ‘ SOLIDWORKS CAM TBM a0

RLEEPEEB T SR T

"

S ER e C By
v

& Bracket (Default<<Default>_Dis
> [@lHistory
[ sensors
» [&] Annotations
> [IMarkups
» [@1Solid Bodies(1)
$% Material <not specified>
[ Front Plane
i Top Plane }
[Ej Right Plane
1, origin
> @Exﬁrude Thin1

» st 0 (5) Diameter Hole1
{ LPattern1 \
» [3@10.0 (10) Diameter Hole
LPattern2

i Cut-Extrude1

§§ LPattern3 Y

< > | *Isometric

! Model | 3D Views Motion Study 1

Return to the original Bracket Part FeatureManager.

26)
27)

Right-click Extrude-Thin1 in the FeatureManager. The Pop-up Context toolbar is displayed.

Click Roll to End. View the results in the Graphics window.

<° %U "4

v .
4 Desigrtm;m@%l:
» [A&] Annot Feature (Extrude-Thin1)

» Solid B Roll to Previous

Equaﬂ\ Rollt.End
Ei Mater Comment
Ej Eront Parent/Child...

Configure Feature

@ Top PI
[ Right

~N
Origin
> §) Extrud

Delete...
Add to Favorites

Save Selection

F & & X6

’
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Heads-up View toolbar

SOLIDWORKS provides the user with CRORE O @ % -I-

numerous view options. One of the most
useful tools is the Heads-up View toolbar
displayed in the Graphics window when a document is active.

w1

“¥* Dynamic Annotation Views & : Only available with SOLIDWORKS MBD (Model Based
Definition). Provides the ability to control how annotations are displayed when you rotate
models.

In the next section, apply the following tools: Zoom to Fit, Zoom to Area, Zoom out, Rotate
and select various view orientations from the Heads-up View toolbar.

Activity: Utilize the Heads-up View toolbar.

Zoom to Fit the model in the Graphics window.

&
28) Click the Zoom to Fit icon. The tool fits the model to the
Graphics window.

N\

Zoom to Area on the model in the Graphics window.

29) Click the Zoom to Area e icon. The Zoom to Area e
icon is displayed.

Zoom in on the top left hole.

30) Window-select the top left corner as illustrated. View the
results.

De-select the Zoom to Area tool.
31) Click the Zoom to Area D icon.

Fit the model to the Graphics window.

32) Press the fkey.

s souowores | File Edit View Insert Tools Window Help #| AR ES DN 0B T sonomien=Q- 8 2- - 0O X

Rotate the model. & 9 Poensownne B @ Bore © R Ow @ @
5:'5:51 :ﬁ;’f,:ff. b tofed Boss/pase Beniad o porchad Qi toreacur il bl <1 D intersect e
33) Hold the middle mouse B s e R
button down. Drag upward & EIRG/@F PPEPRB O S =T N
b, downward b, to the Ieft Q‘b;;cm (Default< <Default>_Dis T @
» @History |
[se
U and to the right Uto i ,
rotate the model in the " Bt s e @
Graphics window. o =
Loan =
» @) Extrude-Thin1
B Fillet1

» [325.0 (5) Diameter Hole1
35 LPatternt
» [2210.0 (10) Diameter Holet

3¢ Lpattern2
N
<

» B cut-Exrudet
>
R Model | 3D Views | Motion Study 1

£ Lpattern3
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Display a few Standard Views. PIAPEBG - © 2 -
34) Click inside the Graphics window. Eel

toolbar. The model is displayed in the Front view.

35) Click Front @ from the drop-down Heads-up view 'é/% g
1
>

36) Click Right (9 from the drop-down Heads-up view j=jr|=r
toolbar. The model is displayed in the Right view.

37) Click Top from the drop-down Heads-up view PLOAEAR
toolbar. The model is displayed in the Top view.

Display a Trimetric view of the Bracket model.

38) Click Trimetric @ from the drop-down Heads-up view
toolbar as illustrated. Note your options. View the results = Il @ Trimetric

in the Graphics window. - |

SOLIDWORKS Help

Help in SOLIDWORKS is context-sensitive and in HTML format. Help is accessed in many
ways, including Help buttons in all dialog boxes and PropertyManager (or press F1) and

Help @ tool on the Standard toolbar for SOLIDWORKS Help.

w1

B CommandManager and FeatureManagers tabs will vary depending on system setup and
SOLIDWORKS Add-ins.

b
DS SOLIDWORKS

File Edit View Insert Tools Window% *‘ ﬁ'@"g'n' [k' éjé}' Q-8 2-_ O X
@ 3 fSwept Boss/Base @ @ ﬁSwept Cut @ EE @ Rib Wrap .E_ U %

Extruded Revolved i Lofted Boss/Base  Extruded Hole Revolved @ Lofted Cut " illet Linear ‘5 Draft @ Intersect Reference Curves InSta
Boss/Base Boss/Base Cut  Wizard  cyt Pattern Geometry
Boundary Boss/Base . @ Boundary Cut . @ Shell F|Eﬂ Mirror

Features ‘Sketch‘ Markup ‘ Evaluate ‘ MBD Dimensions ‘ SOLIDWORKS Add-Ins ‘ SOLIDWORKS CAM ‘ SOLIDWORKS CAM TBM ‘ 0o - =5 X

--EE PLACHEEC» SR T

% Bracket (Default<<Default>_ "
4 History
Sensors
» [&l Annotations
4 Markups
[@]Solid Bodies(1)
gsMateriaI <not specified> J

m Front Plane

m Top Plane

[J Right Plane

1. Origin

@ Extrude-Thin1

B Fillet1

» [@@5.0 (5) Diameter Hole1
EE LPatternt

» @210 (10) Diameter Hole ¥
EE LPattern2 I

4 Cut—Extrude1 2 X
2 | pattarn3 v

< > | *Isometric
- Model ‘ 3D Views ‘ Motion Study 1
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39) Click Help from the Menu bar.

40) Click Help ® from the drop-down menu. The
SOLIDWORKS Home Page is displayed by default.
View your options.

w1
-~ s

SOLIDWORKS Web Help is active by default
under Help in the Main menu.

Close Help. Return to the SOLIDWORKS Graphics window.

41) Close (X SOLIDWORKS Home.

SOLIDWORKS Tutorials
Display and explore the SOLIDWORKS tutorials.
42) Click Help from the Menu bar.

6D E S

elcome to SOLIDWORKS

Help
SOLIDWORKS CAM
Tutorials

API Help

Use Web Help

Search

S

J el ;

Release Notes
What's New

& Introducing SOLIDWORKS (pdf)
Moving from 2D to 3D

43) Click Tutorials. The SOLIDWORKS Tutorials are
displayed. The SOLIDWORKS Tutorials are
presented by category.

44) Click the Getting Started category. The Getting
Started category provides lessons on parts,
assemblies, and drawings.

In the next section, close all models, tutorials and
view the additional User Interface tools.

E7 SOLIDWORKS Tutorials - O 4

< & &
Show Back Print

SOLIDWORKS Tutorials: Getting Started
Getting Sﬁrted Basic Techniques

Advanced Tethniques Productivity Tools

Design Evaluation CSWP/CSWA Preparation

Activity: Close all Tutorials and Models.

Close SOLIDWORKS Tutorials and models.

a5) Close Edl SOLIDWORKS Tutorials.
46) Click Window, Close All from the Menu bar menu.

User Interface Tools

The book utilizes additional areas of the
SOLIDWORKS User Interface. Explore an overview
of these tools in the next section.
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g

Viewport
= New Window

[ I T )

Cascade
E Tile Horizontally
D] Tile Vertically
Arrange lcons

Close All

=1

~~>

1 Part1 *

2 Bracket.SLDPRT

Browse Open Documents...
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Overview of SOLIDWORKS® and the User Interface

Right-click

Right-click in the Graphics window on a
model, or in the FeatureManager on a
feature or sketch to display the Context-
sensitive toolbar. If you are in the middle
of a command, this toolbar displays a list
of options specifically related to that
command.

Right-click an empty space in the
Graphics window of a part or assembly,
and a selection context toolbar above the
shortcut menu is displayed. This provides
easy access to the most commonly used
selection tools.

Consolidated toolbar

SOLIDWORKS® 2020 Quick Start

RS IS

)

Zoom to Fit
Zoom to Area
Zoom In/Out
Rotate View
Pan

Roll View

Rotate About Scene Floor

OPAVVW

Set Current View As...

View Orientation...

Edit Scene

Show Hidden Components
Open Drawing

Move Component

cHEEBQ

Temporary Fix/Group
Recent Commands
Contour Select Tool

Customize Menu

SR« @
*C =2 p2LBE

Similar commands are grouped together in the CommandManager.
For example, variations of the Rectangle sketch tool are grouped in

a single fly-out button as illustrated.

If you select the Consolidated toolbar button without expanding:

For some commands such as Sketch, the most commonly used
command is performed. This command is the first listed and the

command shown on the button.

For commands such as rectangle, where you may want to
repeatedly create the same variant of the rectangle, the last used
command is performed. This is the highlighted command when the

Consolidated toolbar is expanded.

System feedback icons

SOLIDWORKS provides system feedback by attaching a

symbol to the mouse pointer cursor.

The system feedback symbol indicates what you are

Select Tangency
% Save Selection
Zoom/Pan/Rotate
Recent Commands
Face
o0 Change Transparency
G Create Plane Parallel to Screen
Feature (Extrude-Thin1)
Comment
Parent/Child...
3 Configure Feature
x Delete...
Add to Favorites
% Save Selection
Body
Isolate
Export to DXF / DWG

FeatureWorks...

YAMOMIAS™
O -O-A

. g)rner Rectangle

[=] Center Rectangle

i Q 3 Point Corner Rectangle
Q) 3 Point Center Rectangle
) Parallelogram

g

by | [Re

k. ]

Face - Edge'Dimension- - Vertexq|

selecting or what the system is expecting you to select.

As you move the mouse pointer across
your model, system feedback is
displayed in the form of a symbol,
riding next to the cursor as illustrated.
This is a valuable feature in
SOLIDWORKS.
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Confirmation Corner

When numerous SOLIDWORKS commands are active, a symbol or a set
of symbols is displayed in the upper right-hand corner of the Graphics
window. This area is called the Confirmation Corner.

When a sketch is active, the confirmation corner box displays two
symbols. The first symbol is the sketch tool icon. The second symbol is a
large red X. These two symbols supply a visual reminder that you are in
an active sketch. Click the sketch symbol icon to exit the sketch and to
save any changes that you made.

When other commands are active, the confirmation corner box provides a
green check mark and a large red X. Use the green check mark to execute
the current command. Use the large red X to cancel the command.

w1
“¥* Confirm changes you make in sketches and tools by using the D
keyboard shortcut to move the OK and Cancel buttons to the pointer

location in the Graphics window.

Heads-up View toolbar

Overview of SOLIDWORKS® and the User Interface

SOLIDWORKS provides the user
with numerous view options from

Standard Views

J ¥BEITTeEI

the Standard Views, View and
Heads-up View toolbar. View

oy

The Heads-up View toolbar is a

BE - - -@3 -

transparent toolbar that is displayed P

in the Graphics window when a e &3 @2 @E gfi @ i @ " ® - @ @ -E3-

document is active.

You can hide, move or modify the
Heads-up View toolbar. To modify
the Heads-up View toolbar, right-
click on a tool and select or deselect
the tools that you want to display.

PROZCR. ©
A Q

~

For a drawing document

The following views are available. Note: available views are document

dependent.

e Zoom to Fit ¢~ : Fit the model to the Graphics window.

e Zoom to Area p : Zoom to the areas you select with a bounding box.

e Previous View 9 : Display the previous view.
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o Section View @: Display a cutaway of Jopr T @@ - L I
g .

a part or assembly, using one or more

cross section planes. - 4 /%
View Selector (Ctrl+SpaceBar)

PY Dynaml'c AnnOtaﬁOl’l VieWS @ . Only Show or hide the in-context View Selector to choose
. . . from a variety of standard and non-standard view
available with SOLIDWORKS MBD. orientations. Press Alt to expose only the back faces of ;Ib
Control how annotations are displayed the View Selector.

when you rotate a model.

—— e

The Orientation dialog has an option to

display a view cube (in-context View

Selector) with a live model preview. This

helps the user to understand how each

standard view orientates the model. With the

view cube, you can access additional standard views. The
views are easy to understand, and they can be accessed
simply by selecting a face on the cube.

To activate the Orientation dialog box, press (Ctrl +

spacebar) or click the View Orientation @ icon from
the Heads up View toolbar. The active model is displayed
in the View Selector in an Isometric orientation (default
view).

Click the View Selector icon in the Orientation dialog
box to show or hide the in-context View Selector.

w1

“¥" Press Ctrl + spacebar to activate the View

Selector. pﬁ@@@f@ﬁg

w1 4% @ @
“¥" Press the spacebar to activate the Orientation pat
dialog box. i (=
g &
. Vzew O{fientation box ¥ ~ Sglect a view ]
orientation or the number of viewports. The

options are: Top, Left, Front, Right, Back,
Bottom, Single view, Two view - Horizontal,
Two view - Vertical, Four view. Click the drop- @ -
down arrow to access Axonometric views:
Isometric, Dimetric and Trimetric.

R T Rk

e Display Style @ ": Display the style for the
active view. The options are: Wireframe,
Hidden Lines Visible, Hidden Lines Removed,
Shaded, Shaded With Edges.

% ® Ol e
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o Hide/Show Items ® " Select items to hide or show in the Graphics g % &0
window. The available items are document dependent. Note the View (g
Center of Mass ¥ icon. 7

\,

e Edit Appearance ?f : Edit the appearance of entities of the model.

o Apply Scene & : Apply a scene to an active part or assembly
document. View the available options.

be

o JView SettingI:I “: Select the following settings: RealView Graphics,
Shadows In Shaded Mode, Ambient Occlusion, Perspective and
Cartoon.

® Rotate view C : Rotate a drawing view. Input Drawing view angle
and select the ability to update and rotate
center marks with view.

# @ H SRS T e
% ¢ = A < SRS B .

I;l B
* 3D Dl”awing I/iew @ : DyHMIcally Q RealView Graphics §
manipulate the drawing view in 3D to @ Sshadows In Shaded Mode a
make a Selectlon_ G Ambient Occlusion = ‘
% Perspective =0
To display a grid for a part, click Options <7, @ G &

Document Properties tab. Click Grid/Snaps,

check the Display grid box. » g Cem ®-@
AR Add a custom view to the Heads-up View ' @
toolbar. Press the space key. The Orientation dialog %pti ons
box is displayed. Click the New View & tool. The Changes options settings for
SOLIDWORKS.

Name View dialog box is displayed. Enter a new
named view. Click OK.

. . . ":lf A ":'“'"”"' "'\"'/‘ OLID‘WORKS CAM TBI:/I
Use commands to display information about the Enaple commandanager 0‘0 &
. o, e . . v se Large Buttons wr = & o
triad or to change the position and orientation of the e [ Features
triad. Available commands depend on the triad's b _ S
context. Surfaces
Sheet Metal
Wl Structure System
= Weldments
" Save space in the CommandManager; limit Mol Tols
. . es odel |ng
your CommandManager tabs. Right-click on a Data Migration
CommandManager tab. Click Tabs. View your = akf‘“g
options to display CommandManager tabs. H Evaluate
¥ | MBD Dimensions
Render Tools
m SOLIDWORKS Add-Ins
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SOLIDWORKS CommandManager

The SOLIDWORKS CommandManager is a Context-sensitive toolbar. By default, it has
toolbars embedded in it based on your active document type. When you click a tab below the
CommandManager, it updates to display that toolbar. For example, if you click the Sketch tab,
the Sketch toolbar is displayed.

w1

“¥* For commercial users, SOLIDWORKS Model Based Definition (MBD) and
SOLIDWORKS CAM is a separate application. For education users, SOLIDWORKS MBD
and SOLIDWORKS CAM is included in the SOLIDWORKS Education Edition.

Below is an illustrated CommandManager for a Part document. Tabs will vary depending on
system setup and Add-ins.

JD’SSOLIDWORKS File Edit View Insert Tools Window Help »# @ D '[E" g v N) ' {é}" B|
|

— ok I o
% g f Swept Boss/Base Dé @ W Swept Cut @ EE @ Rib Wrap ﬂ U h\\'b
Extruded Revolved i Lofted Boss/Base Extruded Hole Revolved m Lofted Cut Fillet Linear B Draft @ Intersect Reference Curves |nstant3D
Boss/Base Boss/Base cut  Wizard  cyt Pattern Geometry

@ Boundary Boss/Base @ Boundary Cut @ Shell F‘Eﬂ Mirror

Features ‘ Sketch‘ Evaluate ‘ MBD Dimensions ‘ SOLIDWORKS Add-Ins ‘ SOLIDWORKS CAM ‘ p @ @ @ . @ - - % & . |:|

Q’ <\ ‘/@[U % @ t EJilﬂMirrorEntities %JQ @ Ed &

BUEy Smart 5. QY. @ o A Trim  Convert Offset [ | inear Sketch Pattern - DisPlay/Delete Repair Rapid Instant2D| Shaded
Sketch| Dimension enet Entities Entities Entities [BlE) Relations  sketch Sketch Sketch

. } - @ j -3 i 3 Surface E - } i Contours
Features Sketch‘ Evaluate ‘ MBD Dimensions ‘ SOLIDWORKS Add-Ins ‘ SOLIDWORKS CAM ‘ /@ Q &g @ E fi @ - E - Q: -

g @ $# @ G check & Devation Analysis [{) Dratt Anlysis S e
i N . . Check
'n;rlf:&?s:e Measiice Pr::zsr;es Pf:sgglnes en=ac Zebra Stripes @ Undercut Analysis Acfi:e
. Curvature @ Parting Line Analysis Dogment
Features | Sketch | Evaluate = MBD Dimensions | SOLIDWORKS Add-Ins | SOLIDWORKS CAM | OO LSMMARE R - SO a
XXX XXX
$ @B ¥ = &H B
Auto Location Size Basic Pattern Datum Geometric
Dimension Dimension Dimension Location  Feature Tolerance
Scheme Dimension
Features ‘ Sketch ‘ Evaluate ‘ MBD Dimensions ‘ SOLIDWORKS Add-Ins ‘ SOLIDWORKS CAM
T

@ @ % & T & T B

3DEXPERIENCE CircuitWorks PhotoView ScanTo3D SOLIDWORKS SOLIDWORKS SOLIDWORKS SOLIDWORKS TolAnalyst
Marketplace 360 Motion Routing Simulation Toolbox

Features ‘ Sketch ‘ Evaluate MBD Dimensions ‘ SOLIDWORKS Add-Ins ‘ SOLIDWORKS CAM ‘ OOREBRED- W) - - % ﬁ -]

g N

‘\(I}'/ @ @ptions

“¥" Set button size from the Toolbars tab of the Customize dialog
box. To facilitate element selection on touch interfaces such as
tablets, you can set up the larger Size buttons and text from the
Options menu (Standard toolbar).

Customize...
Add-Ins...

Save/Restore Settings...

-~y
\‘Button Size
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The SOLIDWORKS CommandManager is a Context-sensitive toolbar that automatically
updates based on the toolbar you want to access. By default, it has toolbars embedded in it

based on your active document type. The available tools are feature and document dependent.

Below is an illustrated CommandManager for a Drawing document. Tabs will vary
depending on system setup and Add-ins.

m m Y “« g

LB 8 & 3 8Q M KHEIE

D= O 0 ‘¢ Q L |G
Standard Model Projected Auxiliary Section Removed Detail Broken-out Break Crop Alternate

3View View View View View Section View Section View View Position
View

View Layout ‘ Annotation ‘ Sketch ‘ Evaluate ‘ SOLIDWORKS Add-Ins ‘ Sheet Format ’i

<\ <& Ahé i A AAA VR ;D Balloon V/_ Surface Finish [E[03]Geometric Tolerance 'G} Center Mark A Revision Symbol @

Smart  Model Spell Format Note Linear (7 Auto Balloon /7<Weld s Blocks [} 5 - Tables
. . ymbol Datum Feature Centerline Revision Cloud
Dimension jtems Checker Painter Note 2 ! {:3
. Parfem n Magnetic Line LI@ Hole Callout Datum Target . % Area Hatch/Fill .
View Layout | Annotation ‘Sketch‘ Evaluate ‘ SOLIDWORKS Add-Ins ‘ Sheet Format i A BN O A B P a
. (47! H 1
!
<\ / M @ © N - o % lC Eﬂil{l Mirror Entities |
Smart Trim . Display/Delete
] ¢ E - 0 - @ - - Offset EE Linear Sketch Pattern  ~ ~'°P y/.
Dimension Cocd Entities Entities Relations

@0 1 |. . -

View Layout ‘ Annotation ‘ Sketch ‘ Evaluate ‘ SOLIDWORKS Add-Ins ‘ Sheet Format i

v B PF b B % B

Spell Measure Markup Section Compare Check DriveWorksXpress
Checker Properties Performance Documents Active Wizard
Evaluation Document

View Layout ‘ Annotation ‘ Sketch ‘ Evaluate ‘ SOLIDWORKS Add-Ins | Sheet Format %

®@ @ @ % & T 6 [ K

3DEXPERIENCE CircuitWorks PhotoView ScanTo3D SOLIDWORKS SOLIDWORKS SOLIDWORKS SOLIDWORKS TolAnalyst
Marketplace 360 Motion Routing Simulation Toolbox

View Layout ‘ Annotation ‘ Sketch ‘ Evaluate ‘ SOLIDWORKS Add-Ins | Sheet Format

Edit | Title Automatic
Sheet | Block Border
Format Fields

View Layout ‘ Annotation ’Sketch‘ Evaluate ‘ SOLIDWORKS Add-Ins ‘ Sheet Format

.-

“¥* To add a custom tab, right-click on a tab and Enable CommandManager
click Customize CommandManager. You can also Lz L Eitons i T
select to add a blank tab and populate it with custom Tobs

. . Toolb
tools from the Customize dialog box. CZ;;:;_"

SOLIDWORKS, AdA-Inc | catimaneis can | cariny

be
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The SOLIDWORKS CommandManager is a Context-sensitive toolbar that automatically
updates based on the toolbar you want to access. By default, it has toolbars embedded in it
based on your active document type. The available tools are feature and document dependent.

Below is an illustrated CommandManager for an Assembly document. Tabs will vary
depending on system setup and Add-ins.

B B B P & B WP R SN E @ F

Edit Insert Mate Component  Linear Smart Move Show Assembly Reference New  Bill of Exploded j Update Take Large
Component Components P Component Fasteners Component  Hidden  Features Geometry Motion Materials — View Speedpak Snapshot Assembly
Wi Pattern Components Study Settings

Assembly ‘ Layout ‘ Sketch ‘ Markup ‘ Evaluate ‘ SOLIDWORKS Add-Ins ‘ {@ /Q @ ﬁ ﬁ ;g @ . E B @\ . Q & . |:_| -

g &/ ONBH @ C @ woome : ~ oo P B &
Create  Smart E(\,O,A Convert (et Offset . te R

. Insert  Mate Move  Show
layout Dimension Entities on S Components Component  Hidden

B “ @ c ) B Surface tit . . : Insert Block : Components
Assembly | Layout | Sketch | Markup | Evaluate | SOLIDWORKS Add-ins | PDOLMAEB R.- - S 1. o

<\ /v@v[Uv ;::(1' @ @ Mirror Entities lz @
Sketch  Smart E . 0 . @ . ’/_z Trim  Convert Offset Offset Ui St B © Display/Delete Repair | Quick | Rapid (IRStant2E
Dimension Entities Entities Fntities  On

Relations Sketch | Snaps | Sketch

} } o @ o | . . Surface Move Entities -
Assembly | Layout ‘ Sketch ‘ Markup ‘ Evaluate ‘ SOLIDWORKS Add-Ins ‘ © Q P @w
=2 % 0K

=
Color Draw Erase| Select Touch Note

Features ‘ Sketch ‘ Markup | Evaluate MBD Dimer|

= @ 0 ) o o
o = B ¥ ¢ &G 8 b B B @ B I N & B &
Design Interference Clearance ~ Hole ~Measure Markup Mass  Section Sensor Assembly Performance Curvature Symmetry Body ~Compare ~ Check i i FloXpress Dri inabili
Study  Detection Verification Alignment Properties Properties Visualization ~Evaluation Check Compare Documents  Active Analysis Wizard  Analysis Wizard Costing

Document Wizard
Assembly[uyout\sketch [ Markup‘ Evaluate ‘ SOLIDWORKS Add-Ins \ POL ZAEL- - M - 00 . & X !

®@ ® @ % & TE 6

3DEXPERIENCE CircuitWorks PhotoView ScanTo3D SOLIDWORKS SOLIDWORKS SOLIDWORKS SOLIDW
Marketplace 360 Motion Routing

] =

Beam Bearing

Simulation Calculator... Calculator...

Assembly ‘ Layout ‘ Sketch ‘ Markup ‘ Evaluate ‘ SOLIDWQRKS Add-Ins [

q

w1
-~

" The Ink Markup toolbar is renamed to the Markup
toolbar. The Markup tab is displayed by default in the Markup [ |
CommandManager on some systems. You can draw

. : ) =
markups with a mouse on non-touch devices, display
, . . BB toolbar for touch devi
bounding boxes for markups, create markups in drawings, S oo AT or oren eV

and use the context toolbar to access markup options.

Marku
The Markup toolbar displays different options depending on the " a

=-EZeoh £
Marksp tog it . =&
deV1}clec.1Dr'aw' and Touch ' A2 are not available for non- IETE toolbar for nontouch devices
touch devices.
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Float the CommandManager. Drag the Features, Sketch or any
CommandManager tab. Drag the CommandManager anywhere
on or outside the SOLIDWORKS window.

To dock the CommandManager, perform one of the following:

While dragging the CommandManager in the SOLIDWORKS
window, move the pointer over a docking icon -

Dock abave Dackleft Dockright and click the needed

command.

Double-click the floating CommandManager to revert the
CommandManager to the last docking position.

Screen shots in the book were made using SOLIDWORKS
2020 SPO running Windows® 10.

Selection Enhancements

Right-click an empty space in the Graphics window of a part or
assembly; a selection context toolbar above the shortcut menu
provides easy access to the most commonly used selection
tools.

e Box Selection i--. Select entities in parts, assemblies, and
drawings by dragging a selection box with the pointer.

e Lasso Selection <. Select entities by drawing a lasso
around the entities.

e Selection Filters ?}'. List of selection filter commands.

e Select Other . Display the Select Other dialog box.
e Select . Display a list of selection commands.

e Magnified Selection (. Display the magnifying glass,
which gives you a magnified view of a section of a model.

w1

¥ Save space in the CommandManager, right-click in the
CommandManager and un-check the Use Large Buttons with
Text box. This eliminates the text associated with the tool.
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Enable CommandManagerw

@ 3DEXPERIENCE Marke...
@ CircuitWorks
O PhotoView 360

@O ScanTo3D
@ SOLIDWORKS Motion
:E SOLIDWORKS Routing

@ SOLIDWORKS Simulati...

E SOLIDWORKS Toolbox

EI TolAnalyst

is ‘MBD Dimensions ‘Evaluate ‘Sketch ‘Features

oy -

Zoom to Fit
p Zoom to Area
12 Zoom In/Out

Q

€' Rotate View

% Ppan

G Roll View

Rotate About Scene Floor
Set Current View As...

View Orientation...

Edit Scene

Show Hidden Components
Open Drawing

Move Component

FCHREDQ

Temporary Fix/Group
Recent Commands
Contour Select Tool

Customize Menu

E Enable CommandManager
Z| Use Large Buttons with Text
Tabs
Toolbars

Customize...
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FeatureManager Design Tree

The FeatureManager consists of various tabs:

o FeatureManager design tree N tab.
e PropertyManager tab.

o  ConfigurationManager [ tab.

e DimXpertManager & tab.

e DisplayManager é tab.

o CAM FeatureManager tree N\ tab.
o  (CAM Operation tree ! tab.

o CAM Tools tree ﬂ tab.

[a ol
Click the ﬂ direction arrows to expand or
collapse the FeatureManager design tree.

CommandManager and FeatureManager tabs and
folder files will vary depending on system setup

and Add-ins.

Select the Hide/Show FeatureManager Area tab

;&E as illustrated to enlarge the Graphics window

for modeling.

_”Q\_ The Sensors tool

SOLIDWORKS® 2020 Quick Start

% Bracket (Default< <Default>_Display State 1>)
» [@ [©] History

Sensors

[Al Annotations

Solid Bodies(1)

25 Material <not specified>
GJ Front Plane

m Top Plane

[J Right Plane

1., origin

@ Extrude-Thin1

B Fillett

3 @5.0 (5) Diameter Hole1
EE LPattern1

3@10.0 (10) Diameter Hole1
EE LPattern2

Cut-Extrude1

EE LPattern3

v

-

v

v

-

-

/) Top Plane

Ej Right Plane
I_, Origin

@ Extrude-Thin1

® Fillet1 l
(& @5.0 (5) Diameter H [

EE LPattern1

Hide FeatureManager Tree Area

(& @10.0 (10) Diametel
EE LPattern2
Cut-Extrude1

EE LPattern3

: [
located in the FeatureManager E = = =
monitors selected properties in a < Sensor ©)

art or assembly and alerts you
p Y Y @ FLATBAR (Default< <Default>_D VX m
when values deviate from the B Hict
. O Q| History
specified limits. There are five - Sensor Type ”
sensor types: Simulation Data, s Bannd Add JE‘ISOI’... Mass Properties v
Mass properties, Dimensions, SMate  Notiffcations... Properties ~
Measurement and Costing Data. [ Fron|  Rename tree item Mass v
(l Top Hide/Show Tree Items.. @
[ Righ Collapse Items
1, origi Customize Menu
Value : 0.0113609512 Ib
|:|Alert v

PAGE 1-26




SOLIDWORKS® 2020 Quick Start

Overview of SOLIDWORKS® and the User Interface

Various commands provide the ability to control
what is displayed in the FeatureManager design
tree.

1. Show or Hide FeatureManager items.

w s
-~ s

Click Options & from the Menu bar.
Click FeatureManager from the System
Options tab. Customize your FeatureManager
from the Hide/Show tree Items dialog box.

2. Filter the FeatureManager design tree. Enter

information in the filter field. You can filter by o

Type of features, Feature names, Sketches,

eeeeeeeeeeeeeeeeeee

Cancel Help

Folders, Mates, User-defined tags and Custom
properties.

w1

“¥" Tags are keywords you can add to a
SOLIDWORKS document to make them easier to filter
and to search. The Tags & icon is located in the bottom
right corner of the Graphics window.

w s

A Collapse all items in the FeatureManager, right-
click and select Collapse items, or press the Shift + C
keys.

The FeatureManager design tree and the Graphics
window are dynamically linked. Select sketches,
features, drawing views, and construction geometry in
either pane.

Split the FeatureManager design tree and either display
two FeatureManager instances, or combine the
FeatureManager design tree with the
ConfigurationManager or PropertyManager.

Move between the FeatureManager design tree,
PropertyManager, ConfigurationManager,
DimXpertManager, DisplayManager and others by
selecting the tab at the top of the menu.
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The ConfigurationManager I3 tab is located to the right of the Eﬁ‘ EN- S
PropertyManager £ B tab. Use the ConfigurationManager to ey |
ontigurationivianager
create, s§lect and view multiple configurations of parts and + @, @ FLATBAR DesignTable Con
assemblies. » [ Tables
The icons in the ConfigurationManager denote whether the [ « Default [ GIDS-5C-100(
configuration was created manually or with a design table. [ — 3HOLE [ GIDS-5C-1000
&‘ S5HOLE [ GIDS-SC-1000
The DimXpertManager & tab provides the ability to insert [ — 7HOLE [ GIDS-SC-1000

dimensions and tolerances manually or automatically. The
options are: Auto Dimension Scheme @, Auto Pair
Tolerance 3, Basic, Location Dimension ™1, Basic Size

Dimension D\ General Profile Tolerance 5@ , Show
Tolerance Status %o , Copy Scheme “* , Import Scheme %

TolAnalyst Study EI and Datum Target = & ‘ B & ‘ S ‘ @\E_ %

s v dl y
=R
A TolAnalyst is available in SOLIDWORKS &b o D E D
Premium.
Fly-out FeatureManager —

» & £ aTBAR-DesignTa

The fly-out FeatureManager design tree History
provides the ability to view and select items in EE LPatternt @ Sensors
the PropertyManager and the FeatureManager v X Ll Design Binder
design tree at the same time. Direction 1 ~g A””°tati°”5
» [@) solid Bodies(1)

Throughout the book, you will select commands ‘Edge{b ‘ Equations
and command options from the drop-down @ spacing and instances 858 6061 Alloy
menu, fly-out FeatureManager, Context toolbar, O Up to reference [J Front Plane
or from a SOLIDWORKS toolbar. <3 0500in I [ Top Plane

sl =l [ra . Gj Right Plane

s I_. Origin

" Another method for accessing a command
is to use the accelerator key. Accelerator keys

. - v
Direction 2 > @j Boss-Extrude 1

Features and Faces A ] » ut-Extrude1

are special keystrokes, which activate the drop- & [Cotxruder B et
down menu options. Some commands in the
menu bar and items in the drop-down menus @
have an underlined character. :

D Bodies v

Instances to Skip v

Options ~

Vary sketch

|:| Geometry pattern
Propagate visual

properties
Orull preview
@ Partial preview 7
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Task Pane

The Task Pane is displayed when a SOLIDWORKS session starts. You can show,
hide, and reorder tabs in the Task Pane. You can also set a tab as the default so it
appears when you open the Task Pane, pin or unpin to the default location.

The Task Pane contains the following default tabs:
e  SOLIDWORKS Resources @

o Design Library @ .

o File Explorer = .

o View Palette .

e

e Appearances, Scenes and Decals
e Custom Properties .

e SOLIDWORKS Forum 7.

AR Additional tabs are displayed with Add-Ins.

Use the Back and Forward buttons in the Design Library tab
and the Appearances, Scenes, and Decals tab of the Task Pane
to navigate in folders.

SOLIDWORKS Resources

The basic SOLIDWORKS Resources ﬁ menu displays the
following default selections:

o  Welcome to SOLIDWORKS.

e  SOLIDWORKS Tools.

e  Online Resources.

e Subscription Services.

Other user interfaces are available during the initial software

installation selection: Machine Design, Mold Design,
Consumer Products Design, etc.
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i TR AN =D

® - G

> /Bga“ck lesign Library

T Toolbox
v @ 3D ContentCentral
> €& Supplier Content
> @ User Library
v §J SOLIDWORKS Content
V= Blocks
V= CircuitWorks
> =7 Routing
= Weldments

B0 s

®

00|
11

3

& Welcome to SOLIDWORKS

SOLIDWORKS Tools
@ Property Tab Builder

@ SOLIDWORKS Rx

@ Performance Benchmark Test
@Compare My Score

& Copy Settings Wizard

@ My Products

Online Resources
@ 3DEXPERIENCE Marketplace

@ Partner Solutions

Subscription Services

@ Subscription Services
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Design Library

The Design Library @ contains reusable parts, assemblies,

and other elements including library features.

The Design Library tab contains four default selections. Each

default selection contains additional sub-categories.

The default selections are:

o Design Library.
e Toolbox.
e 3D ContentCentral (Internet access required).
o  SOLIDWORKS Content (Internet access
required).
w1

A Activate the SOLIDWORKS Toolbox. Click
Tools, Add-Ins.., from the Main menu. Check the
SOLIDWORKS Toolbox Library and
SOLIDWORKS Toolbox Utilities box from the Add-
ins dialog box or click SOLIDWORKS Toolbox
from the SOLIDWORKS Add-Ins tab.

To access the Design Library folders in a non-

network environment, click Add File Location @
and browse to the needed path. Paths may vary
depending on your SOLIDWORKS version and
window setup. In a network environment, contact your
IT department for system details.

File Explorer

File Explorer = duplicates Windows Explorer from
your local computer and displays:

e  Recent Documents.

o Samples.

e Open in SOLIDWORKS
e Desktop.
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Design Library

GRS
> [ Design Library
T Toolbox
v 3D ContentCentral
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T [=Blocks
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/
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®

ulli
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<1s

OOooQgoooao

<1s

<1s

Oooo
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Search

The SOLIDWORKS Search box is displayed in the upper right corner

of the SOLIDWORKS Graphics window (Menu Bar toolbar). Enter
the text or key words to search.

New search modes have been added to SOLIDWORKS Search as
illustrated.

View Palette

The View Palette tool located in the Task Pane

Search Knowledge Base QEL
Y

& Commands
Files and Models
MySolidWorks

Knowledge Base

OB odETHES

Community Forum I
Blogs
CAD Models
Training
Youtube !
Twitter

provides the ability to insert drawing views of an active “ e ﬁ .l
document, or click the Browse button to locate the desired Options
document.

Click and drag the view from the View Palette into an
active drawing sheet to create a drawing view.
[ \

N The selected model is LINKAGE in the illustration.

w1

Import Annotations

O Design Annotations
DimXpert Annotations

|:| Include items from hidden featureg

D 3D View Annotations

Auto-start projected view

Drag views onto drawing sheet.

LI IENIEIE

aq\ “ A
*Front *Right
o= /’:J
*Top *Back
A i o
*Left *Bottom
*Isometric *Dimetric
™ ™ v
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Appearances, Scenes, and Decals

X <« Appearances, Scenes, and Decaléﬁ} x*
@ - @ WS
Appearances, Scenes, and Decals provide a simplified N
way to display models in a photo-realistic setting using a o > Scenes
. > [@ Decals
library of Appearances, Scenes, and Decals. il et
An appearance defines the visual properties of a model, =
including color and texture. Appearances do not affect
physical properties, which are defined by materials. \ﬁs
Scenes provide a visual backdrop behind a model. In
SOLIDWORKS they provide reflections on the model. —
PhotoView 360 is an Add-in. Drag and drop a selected =
appearance, scene or decal on a feature, surface, part or ‘
assembly. YLK Custom Properties oy R
Apply I Reset
Custom Properties By Ay o et e
_ @ launch the Property Tab Builder.
The Custom Properties tool provides the ability to lfyou lready have a template lace
enter custom and configuration specific properties directly LA Goion- _FnepLocations - Custom
into SOLIDWORKS files. Propery Fles
e Press F5 to refresh the page.
SOLI DWORKS Forum \ ‘ Create now...
Click the SOLIDWORKS Forum == icon to search =
directly within the Task Pane. An internet connection is
. . . . < = SOLIDWORKS Forum <53 ®
required. You are required to register and to log in for SOLIDWORKS Forum
postings and discussions. search IS
@ maximom volume filing capaciies-find the heights of volume
User Interface for Scaling High Resolution o LR e
= FORUMS 12 hours ago
Screens | S
The SOLIDWORKS software supports high-resolution, e
high-pixel density displays. All aspects of the user interface | c TR ey ago
respond to the Microsoft Windows® display scaling setting. 1 day ago
In dialog boxes, PropertyManagers, and the +*, : 2y ago
FeatureManager design tree, the SOLIDWORKS software o roRuMs 3 cayage

uses your display scaling setting to display buttons and
icons at an appropriate size. Icons that are associated with o3 FLATBAR-DesignTablg
text are scaled to a size appropriate for the text. In addition, £33 “options

for toolbars, you can display Small, Medium, or Large
buttons. Click the Options drop-down arrow from the
Standard Menu bar, and click Button size to size the icons.

Customize...
Add-Ins...
Save/Restore Settings...

Button Size >
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Motion Study tab

Motion Studies are graphical simulations of motion for an assembly. Access the
MotionManager from the Motion Study tab. The Motion Study tab is located in the bottom
left corner of the Graphics window.

BadcMation | By 1> > I 2T ] B AR
I_f \S\T\ [T \TI‘\ I \S\T\ I \S\T\ [T \S\T\ I \T\c\ (AN \T\c\ [ IT\C\ (NN \T\c\ (AN \Tlc\ [ Hs\“\ (NN Hs\ﬂ\ (AN Hs\“\ (il HT(\
Y L0 A O A P s AT (o
ol - @ Motion St ‘
& Orient .
4 Lights ‘
—Q Linear| .
o Gravit| .
o » (@ inran B
<
- Model | 3D Views Motioﬂ>§tudy1 ‘
Incorporate visual properties such as lighting and camera
perspective. Click the Motion Study tab to view the
MotionManager. Click the Model tab to return to the
FeatureManager design tree.
The MotionManager displays a timeline-based interface and
provides the following selections from the drop-down menu as
illustrated:
o Animation: Apply Animation to animate the motion of an
assembly. Add a motor and insert positions of assembly
components at various times using set key points. Use the
Animation option to create animations for motion that do not
require accounting for mass or gravity. N —_— *‘ O = e
e Basic Motion: Apply Basic Motion for 2 Redraw~ cut+r (] Enable CommandMianager
. . . S Capt )
approximating the effects of motors, springs, e & 201030
.. . . . Displ o || ign
collisions and gravity on assemblies. Basic Moty 1% Annotation
Motion takes mass into account in calculating Lights and Cameras ' % ’;“e:‘b'y
. . . . . . A OCKS
motion. Basic Motion computation 1s relatlvely Hide / Show " [& Configurations
fast, so you can use this for creating Toolbars Q\ : E{ Bies _
. . . . . Workspa » | <L Dimensions/Relations
presentation animations using physics-based Veor iorrtnce .
simulations. Use the Basic Motion option to & Touch Mode © MED Dimension
. . . Display Statt
create simulations of motion that account for [~ s " oming
mass, collisions or gravity. Customize Men @ Explode Sketch
@ Features
s I'/_ Bf Formatting
“¥" If the Motion Study tab is not displayed in the Laver
. . . . @ Layout Tools
Graphics window, click View > Toolbars > L = Line Format
MotionManager from the Menu bar. . ) Macro
| {7 Markup
@ Mold Tools
tionManager
= N
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3D Views tab

SOLIDWORKS MBD (Model Based Definition
you create models without the need for drawings
you an integrated manufacturing solution. MBD

companies define, organize, and publish 3D product and
manufacturing information (PMI), including 3D model

data in industry standard file formats.

Create 3D drawing views of your parts and assemblies
that contain the model settings needed for review and
manufacturing. This lets users navigate back to those

SOLIDWORKS® 2020 Quick Start

Capture 3D View

) lets
giving
helps

Sort order:

v

History

Update Previews

mke

- Model}Views Motion Study 1

settings as they evaluate the design.

Use the tools in the MBD Dimensions
CommandManager to set up your model with
selected configurations, including explodes

2 ) v ) D =]
2S soLibworks  File Edit View Insert Tools Window Help *‘ < o

¢ B & ™ &L @ em

Auto Location Size Basic  pattern Datum Geometric
Dimension Dimension Dimension Location  Feature
Dimension

Tolerance
Scheme

Features ‘ Sketch  Markup ‘ Evaluate  MBD Dimensions ‘ SOLIDWORKS Add-Ins ‘ B

and abbreviated views, annotations, display

N

states, zoom level, view orientation and
section views. Capture those settings so that you
using the 3D view palette.

and other users can return to them at any time

To access the 3D View palette, click the 3D Views tab at the bottom of the SOLIDWORKS
window or the SOLIDWORKS MBD tab in the CommandManager. The Capture 3D View
button opens the Capture 3D View PropertyManager, where you specify the 3D view name,
and the configuration, display state and annotation view to capture. See SOLIDWORKS help

for additional information.

Dynamic Reference Visualization
(Parent/Child)

Dynamic Reference Visualization provides the
ability to view the parent/child relationships
between items in the FeatureManager design
tree. When you hover over a feature with
references in the FeatureManager design tree,
arrows display showing the relationships. If a
reference cannot be shown because a feature is
not expanded, the arrow points to the feature that
contains the reference and the actual reference
appears in a text box to the right of the arrow.
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Use Dynamic reference visualization for a

Vieyglnsert Tools Window Help *} ﬁ' '@7" tg' '@ {é\}'

part, assembly and mates. Ty e
. . Screen Capture ' @ ? EI
To display the Dynamic Reference iy R i
Visualization, click View » User Modify :
Lights and Cameras » DRKS Add-Ins | SOLIDWORKS CAM ‘ SOLIDWORKS

Interface > Dynamic Reference
Visualization Parent/Child) from the

Hide / Show

Toolbars

Main menu bar. Workspace :
§ Toutnttose D ' wxfgl po

Mouse Movements H :::: - F11 %z Reference Visualization (Child) »
A mouse typically has two buttons: a . EAtEPBMg
primary button (usually the left button) and o
a secondary button (usually the right
button). Most mice also include a scroll ]
wheel between the buttons to help you 9
scroll through documents and to Zoom . T
in, Zoom out and rotate models in o Lﬁ—_ g
SOLIDWORKS. It is hlghly \'}Q\l‘.:_-_—_—_-_‘.'.'_':.'.‘:.‘.'—'—l.:\: ';,— — .-‘\.\
recommended that you use a mouse = \
with at least a Primary, Scroll and . 4
Secondary button. ] _ e

(1) Primary button (2) Scroll wheel (3) Secondary button
Single-click

To click an item, point to the item on the screen, and then press and release the primary button
(usually the left button). Clicking is most often used to select (mark) an item or open a menu.
This is sometimes called single-clicking or left-clicking.

Double-click

To double-click an item, point to the item on the screen, and then click twice quickly. If the
two clicks are spaced too far apart, they might be interpreted as two individual clicks rather
than as one double-click. Double-clicking is most often used to open items on your desktop.
For example, you can start a program or open a folder by double-clicking its icon on the
desktop.

Right-click

To right-click an item, point to the item on the screen, and then press and release the
secondary button (usually the right button). Right-clicking an item usually displays a list of
things you can do with the item. Right-click in the open Graphics window or on a command in
SOLIDWORKS, and additional pop-up context is displayed.

Scroll wheel

Use the scroll wheel to zoom-in or to zoom-out of the Graphics window in SOLIDWORKS.
To zoom-in, roll the wheel backward (toward you). To zoom-out, roll the wheel forward
(away from you).
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Summary

SOLIDWORKS® 2020 Quick Start

The SOLIDWORKS (Ul) is designed to make maximum use of the Graphics window for
your model. Displayed toolbars and commands are kept to a minimum.

The SOLIDWORKS User Interface and CommandManager consist of the following main
options: Menu bar toolbar, Menu bar menu, Drop-down menus, Context toolbars,
Consolidated fly-out menus, System feedback icons, Confirmation Corner and Heads-up

View toolbar.

The Part CommandManager controls the display
of tabs: Features, Sketch, Markup, Evaluate,
MBD Dimensions and various SOLIDWORKS
Add-Ins.

The FeatureManager consists of various tabs:

o FeatureManager design tree N tab.
e PropertyManager tab.

o ConfigurationManager fa tab.

e DimXpertManager & tab.

e DisplayManager é tab.

o (CAM FeatureManager tree @ tab.
o  (CAM Operation tree g. tab.

o CAM Tools tree ? tab.

(s 3
4

Click the %L direction arrows to expand or
collapse the FeatureManager design tree.

CommandManager and FeatureManager tabs and
file folders will vary depending on system setup
and Add-ins.

N
s sovipworks  File Edit View Insert Tools Window Help *‘ ﬁ = Z)yvi
@ 3 f Swept Boss/Base ﬂé @ ﬁ Swept Cu

Extruded Revolved i Lofted Boss/Base Extruded Hfﬂe Revolved @ Lofted Cd
Boss/Base Boss/Base Cut Wizard ¢yt

Boundary Boss/Base Bounda

Features ‘ Sketch‘ Markup ‘ Evaluate = MBD Dimensions ‘ SOLIDWORKS Add-Ins
I

ERoS
v

% Bracket (Default<<Default>_Display State 1>)
4 History

Sensors

Annotations

Solid Bodies(1)

55 Material <not specified>
EQ Front Plane

[ Top Plane

[J Right Plane

i, Origin

@ Extrude-Thin1

@ Fillet1

& 5.0 (5) Diameter HoleT
E% LPatternt

& @10.0 (10) Diameter Hole1
E% LPattern2

Cut-Extrude1

EE LPattern3

& A,
/

-

-

-

-

-

-

You learned about creating a new SOLIDWORKS part and opening
an existing SOLIDWORKS part along with using the Rollback bar

to view the sketches and features.

w s
LN

If you modify a document property from an Overall drafting
standard, a modify message is displayed as illustrated.
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w s
-~ s

Use the Search box, in the upper left corner of the Materials
dialog box, to search through the entire materials library.

Material

Search... %

Templates are part, drawing and assembly documents which

include user-defined parameters. Open a new part, drawing or « [ SOLIDWORKS Materials
assembly. Select a template for the new document. v [Esteel

In Chapter 2, establish a SOLIDWORKS session. Learn
about 2D Sketching and 3D features.

Create a new part. Create the Wheel for the Fly Wheel sub-
assembly.

Utilize the Fly Wheel sub-assembly in the final Stirling
Engine assembly.

Apply the following sketch and feature tools: Circle, Line
Centerline, Centerpoint Straight Slot, Mirror Entities,
Extruded Boss, Extruded Cut, Revolved Boss, Circular
Pattern, Hole Wizard and Fillet.

Incorporate design change into a part using proper design
intent, along with applying multiple geometric relations:
Coincident, Vertical, Horizontal, Tangent and Midpoint
and feature and sketch modifications.

Utilize the Material, Mass Properties and Appearance tool
on the Wheel.

PAGE 1-37



Overview of SOLIDWORKS® and the User Interface SOLIDWORKS® 2020 Quick Start

Notes:
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